
1 
 

 

 
Desk Phone User Guide 

 
 
 

 

 
 

 
 
 

 
 
 

 
 

 

Speaker 

Redial 

Voicemail 

Headset 

Mute 

Park Buttons 
Line Buttons 

Soft Keys 

Volume Controls 

Navigation Buttons 



2 
 

Contents 
Basic Calling and Call Control .................................................................................................................................................................................... 3 

Inbound Calls ....................................................................................................................................................................................................... 3 

Placing Outbound Calls ........................................................................................................................................................................................ 3 

Hold ..................................................................................................................................................................................................................... 4 

Transfer................................................................................................................................................................................................................ 5 

Conference Calls .................................................................................................................................................................................................. 6 

Call Park ............................................................................................................................................................................................................... 7 

Placing a Call On Park ..................................................................................................................................................................................... 7 

Retrieving a Parked Call .................................................................................................................................................................................. 7 

Call Forwarding .................................................................................................................................................................................................... 8 

To enable call forwarding: .............................................................................................................................................................................. 8 

To disable call forwarding: .............................................................................................................................................................................. 8 

Other Phone Features ............................................................................................................................................................................................... 9 

Volume Control .................................................................................................................................................................................................... 9 

Mute .................................................................................................................................................................................................................... 9 

Do Not Disturb ..................................................................................................................................................................................................... 9 

Call Directory (History) ....................................................................................................................................................................................... 10 

Voicemail ................................................................................................................................................................................................................. 11 

Setting up your voicemail for the first time ....................................................................................................................................................... 11 

Accessing Your Mailbox ..................................................................................................................................................................................... 12 

Re-recording Your Greeting ............................................................................................................................................................................... 12 

Changing Your PIN ............................................................................................................................................................................................. 12 

Extended Absence Greeting (out-of-office) ....................................................................................................................................................... 13 

Recording the Extended Absence Greeting .................................................................................................................................................. 13 

Enabling the Extended Absence Greeting ..................................................................................................................................................... 13 

Disabling the Extended Absence Greeting .................................................................................................................................................... 13 

MaxUC Desktop Client ............................................................................................................................................................................................. 14 

Personal Settings ............................................................................................................................................................................................... 15 

Changing Your Avatar Picture ....................................................................................................................................................................... 15 

Updating Your Status and Availability........................................................................................................................................................... 16 

Placing Calls ....................................................................................................................................................................................................... 17 

Internal Chat / Instant Messaging ...................................................................................................................................................................... 18 

Contacts and Favorites....................................................................................................................................................................................... 19 

Adding Contacts ........................................................................................................................................................................................... 19 

Favorites ....................................................................................................................................................................................................... 20 

Call / Chat History .............................................................................................................................................................................................. 21 

Voicemail Access ................................................................................................................................................................................................ 22 

Other Voicemail Settings ................................................................................................................................................................................... 23 

Voicemail-to-email ....................................................................................................................................................................................... 23 

Voicemail Greeting ....................................................................................................................................................................................... 24 



3 
 

 

Basic Calling and Call Control 
 

All calling (both inbound and outbound) takes place on one of the 
Line buttons located at the top-left of the display. 

 

Inbound Calls 
When a call rings to your phone, an available Line button will begin to flash green and the caller 
ID of the caller will be shown in the display.  Calls from other internal users will show the name 
and extension number of the caller. 

 

 

To answer the call, you may: 

1) Lift the handset 
2) Press the Speaker or Headset button 
3) Press the Answer softkey 

 

 

Placing Outbound Calls 
To place an outbound call, first select an available Line button.  Lines that are in use will be lit 
either red or green and available buttons will be unlit.  

 

1) Go off-hook on an available Line button 
2) Dial the destination (do not dial a 9 first) 

a. Internal extension number 
b. External phone number (7-digit local, 10-digit or 11-digit local and long distance) 

3) Press the # key or Send softkey 

In Use 

Available 
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Hold 
To place a call on hold, start with an active call.  The softkeys at the bottom of the screen will 
then change. 

 

Press the Hold softkey.  The Line button will begin to flash red and the caller will hear the Music 
on Hold message. 

 

To pick up the call from Hold, press the Resume softkey 
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Transfer 
Transfers can be either Blind or Supervised.  A Blind Transfer will ring the destination and 
connect the call immediately.  A Supervised Transfer will allow you to remain on the line and 
announce the call to the destination before connecting the call. 

To transfer a call, start with an active call.  The softkeys at the bottom of the screen will then 
change. 

 

Press the Transfer softkey and the caller will be placed on hold, listening to the Message on 
Hold. 

You will hear a new dial tone and you will dial the transfer destination.  The destination can be: 

- Internal extension numbers 
- Direct telephone numbers 
- External telephone number 

 

To perform a Blind Transfer, press the BTransfer softkey.  The call will be connected and ring to 
the destination and your phone will return to an idle state. 

 

 

To perform a Supervised Transfer, press # or the Send softkey.  The call will begin to ring to the 
destination.  When the destination answers, announce the call and hang up.  When you hang 
up, the transferred call will be connected to the destination. 

 

To cancel a transfer and return to the original call, press the Cancel softkey then the Resume 
softkey and you will be connected to the original call. 
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Conference Calls 
You have the ability to join up to 2 outside parties together into a single Conference Call. 

To join 2 calls together on a Conference Call, start with a live call.  Press the Conference 
softkey. 

 

You will hear a new dial tone and you can dial the second participant.   

 

When the second caller is on the line, press the Conference softkey a second time.  Both calls 
will be joined together and all 3 participants can talk. 

 

Once joined together, the softkeys will change allowing you to manage the Conference Call. 

 

 

Pressing the End Call softkey will disconnect you from the call and the 2 other participants will 
stay connected, allowing them to continue the call. 

Pressing the Hold softkey will place the 2 other participants on Hold and they will hear the 
Message on Hold.  The 2 participants will not be able to talk with each other while on Hold. 

Pressing the Split softkey will remove the participants from the Conference.  The last call joined 
to the Conference will become the active call and the other call will be placed on Hold.   

Pressing the Manage softkey will give additional control options.  Use the Navigation Buttons to 
highlight one of the participants in the call.  The softkeys will change and allow you to Mute, Hold, or 
Remove only the selected participant. 

 

 

 



7 
 

Call Park 
Normally, if a call is placed on Hold using the softkey, only the phone that placed the call on hold will be 
able to pick up the held call at that phone.  If a call needs to be placed on hold and picked up at a 
different phone, the Park buttons will be used instead. 

 

Placing a Call On Park 
To use the Park feature, start with a live call.  Press an available Park button found at the top-right of 
your display.  An available Park button will be lit green. 

 

 

When the call is parked, the caller is hearing the Message on Hold and the selected Park button will 
begin flashing red. 

 

If the call is being parked so that another person can answer the call, that person will need to be notified 
that the call is parked.  You can call them at their extension, use the MaxUC instant messaging service, 
or other method to notify the other person of the parked call. 

 

 

 

Retrieving a Parked Call 
To pick up a call that has been placed on Park, simply press the flashing red Park button associated with 
your call.  Pressing the button will move the call to a live state on your phone.  
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Call Forwarding 
You have the ability to forward your phone to an alternate destination.  This destination can be another 
internal phone extension, internal direct phone number, or external phone number such as a cell phone.  
When entering a phone number, be sure to include the full 10-digit phone number including the area 
code. 

To enable call forwarding: 
1) Dial *72 + <destination number> (i.e. - *722253425055) 
2) Press # or the Send softkey 
3) You will hear a confirmation tone indicating forwarding is active 

 

To disable call forwarding: 
1) Dial *73 
2) Press # or the Send softkey 
3) You will hear a confirmation tone indicating forwarding is disabled 
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Other Phone Features 
 
Volume Control 
The Volume Control key,  adjusts the level of several different volumes. 
Whatever is actively being used is what is controlled by the keys. 

- When the phone is idle, the ringer volume is adjusted 
- When on speaker, the speaker volume is adjusted 
- When on the handset, the earpiece volume is adjusted 

 

 

Mute 

While on an active call, the Mute button will prevent your voice from being transmitted to the 
other caller.  When active, the button will be lit RED. 

To disable mute, simply press the Mute button again. 

 

 

 

Do Not Disturb 
Do Not Disturb, or DND, will disable your phone from receiving incoming calls.  All calls will forward to 
your voicemail.  You may still use the phone for outbound calls. 

To active Do Not Disturb, press the DND softkey.  The display will indicate DND is active. 

 

To disable Do Not Disturb, press the DND softkey again. 

 



10 
 

Call Directory (History) 
The phones will store the latest 10 records of Outbound, Inbound Answered, and Inbound Missed calls. 

To access the Call History, press the History softkey or the Up Navigation Button. 

 

You will be shown a list of All Calls showing all inbound and outbound calls along with the date and time 
of the call. 

 

You can use the Left and Right Navigation Buttons to scroll between Missed Inbound Calls, Placed 
Outbound Calls, and Received (Answered) Inbound Calls. 

You can use the Up and Down Navigation Buttons to scroll through the call records in each list. 

When a call record is higlighted, you may press the Send softkey and a call will be placed to that 
number.  This will work on any number in any call list. 
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Voicemail 
Your phone has a voicemail that will answer calls and take messages should you not be available.  Your 
voicemail will need to be set up initially to personalize it to you. 

 

Setting up your voicemail for the first time 
 

1. Press the Message button or dial *98 
2. Complete the walkthrough 

 
The first time you access your voicemail box, you will be asked to create a PIN, record your name, and 
record a greeting. Following the prompts from the tutorial, you will hear: 
 
Change your PIN 
First, you will be prompted to create your voicemail PIN. It can be between 4 and 6 digits long, not 
sequential numbers or repeating numbers. After entering your new PIN, you will be asked to confirm the 
PIN by re-entering it. 
 
Record a Name 
You will then be prompted to record your name. Once you have recorded your name, it is played back to 
you and you are provided with options to keep it or re-record it. 
- Press 1 to change your recorded name. 
- Press # to keep your recorded name. 
 
Record a Greeting 
Lastly, you will be prompted to record a personal greeting. Once you have recorded your greeting, it will 
be played back to you and you are provided with options to keep it or re-record it. 
- Press 1 to record a personal greeting.  
- Press 1 to change your greeting. 
- Press # to keep your greeting 
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Accessing Your Mailbox 
 
From your phone: 

1. Press the Messages button  or dial *98. 
 
From another phone: 

1. Dial your extension 
2. When your greeting answers, press the * key 
3. Enter your PIN when prompted 

 
 
 
 

Re-recording Your Greeting 
 

1. Access your voicemail box. 
2. Press 3 to Work With Your Greetings. 
3. Press 1 to set up a personal greeting. 
4. You will hear your current greeting. 

a. Press 1 to re-record your personal greeting. 
5. Press 3 to save your new greeting. 

 
 
 
 

Changing Your PIN 
 

1. Access your voicemail box. 
2. Press 4 to Change Your Settings. 
3. Press 3 for Security Options. 
4. Press 1 to Change Your PIN 
5. Enter and confirm your new PIN 
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Extended Absence Greeting (out-of-office) 
 
The Extended Absence Greeting allows you to record a temporary greeting without affecting your 
normal personal greeting.  You also have the ability to turn this temporary greeting on and off as 
needed. 
 
Recording the Extended Absence Greeting 
 

1. Access your voicemail box. 
2. Press 3 to Work With Your Greetings. 
3. Press 2 to Work With Your Extended Absence Greeting. 
4. Press 2 to Review or Re-record It. 

a. Press 1 to Record a New Extended Absence Greeting. 
5. When finished, press * to Exit. 

 

Enabling the Extended Absence Greeting 
 

1. Access your voicemail box. 
2. Press 3 to Work With Your Greetings. 
3. Press 2 to Work With Your Extended Absence Greeting. 
4. Press 1 to Turn On Your Extended Absence Greeting 

 
Callers will now begin to hear the Extended Absence Greeting 
 
 

Disabling the Extended Absence Greeting 
 

1. Access your voicemail box. 
2. Press 3 to Work With Your Greetings. 
3. Press 2 to Work With Your Extended Absence Greeting. 
4. Press 1 to Turn Off Your Extended Absence Greeting 

 
Callers will now begin to hear the normal Personal Greeting 
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MaxUC Desktop Client 
 
The MaxUC desktop client is an application that will expand the capabilities of your desk phone and give 
you additional features that will benefit your daily work. 
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Personal Settings 
 
Changing Your Avatar Picture 
 
Click the face icon next to your name and choose, Change Avatar. 
 

 
 
In the window that opens, click either the Choose or Take a Photo buttons to create a picture.  Adjust 
the photo to fit in the frame and finish by clicking Save. 
 

 
 
Your avatar will now synchronize across all devices and display on other MaxUC clients 
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Updating Your Status and Availability 
 
Clicking your name at the top will give you options to change your status and availability that will display 
on other MaxUC clients.   

You can update your presence by choosing either Online or Busy from the Presence section of the 
pulldown.  Selecting either of these options will only change your presence information on other MaxUC 
clients and does not affect calling availability. 

 

 

The Call Manager section will give you additional options that will affect how you receive calls.  You can 
enable and disable Do Not Disturb and Call Forwarding. 

 

 

You can also add additional information to your status using the field immediately below your name.  
Things such as “In a Meeting” or “Conference Call” will provide additional status information to other 
MaxUC clients. 
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Placing Calls 
Calls can be initiated through the MaxUC client which will connect to your desk phone and allow you to 
talk there.   

 

To manually place a call, enter the phone number in the Phone Dialer field.  When finished entering the 
number, click the phone icon to the right. 

 

A window will pop up having you confirm where to take the call.  Leave the selection as Account Phone 
and click Call.  Your desk phone will begin to ring and when you answer, the call will begin to ring to the 
destination entered. 

 

 

You may also use the Phone Dialer to search the Contact List. 

Begin typing the name of the person in the Contact list and the list will automatically filter.  When you 
find the contact you wish to call, click the phone icon to the right of the name. 
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Internal Chat / Instant Messaging 
The MaxUC client allows you to open an internal chat with an individual or a group of people. 

To open a chat with an individual, search for their name in the Contact List.  When you find the contact, 
click the Chat button to open the Chat Window. 

    
 

In the Chat Window, begin typing and your conversation will be displayed in the middle window.  You 
may also send files, call the person, or add additional users to the chat. 

 

 

 

To initiate a Group Chat, go to File > New Group Chat.  You will be shown a new window allowing you to 
select all the people you wish to add to the chat.  Use the Search Bar to filter the list and click the 
checkbox next to everyone you wish to bring into the chat.  You may also change the subject of the chat 
to make it easier to distinguish between other group chats.  Click Create Group Chat when finished. 

                 

Add People Call Person Send File 
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Contacts and Favorites 
 

The Contacts tab will list all of the configured users within the system along with any manually added 
Contacts.  Only internal Contacts will display avatar pictures and updated presence information 
depending on their status.  Internal contacts are updated within the server and should not need to be 
modified by you. 

 

Adding Contacts 
 

You may add additional Contacts to your list manually.  You can do this by going to File > Add Contact. 

Fill out the Contact form that displays.  Not all information is required so you may only enter whatever 
information you have.  Note that if no phone numbers are added, the system will not be able to place a 
call to the Contact. 

 

 

When the Contact information is entered, the Contact will then be shown in the list of Contact on the 
main window. 
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Favorites 
Any Contact may be added to the Favorites tab allowing you to quickly and easily see the Contacts you 
interact with the most. 

To add a Contact to your Favorites, find the Contact in the list.  Use the search bar if needed.  Right-click 
on the Contact and choose Add to Favorites. 

 

 

The Contact will now be shown in the Favorites tab along with the other selected Favorite Contacts. 
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Call / Chat History 
 

The Recent tab will display all history with your account.  This includes both calling and chat history. 

You may also choose to filter out just Calls or just Chats.  Details of the record are included in the list. 

 

 

On any record, you can use the icons to the right to open a chat window with an internal user or place a 
call to the phone number. 

 

 

 

 

 

Call Number Chat w/ User 
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Voicemail Access 
When you have voicemails, the indicator to the right of the Phone Dialer will update. 

 

Click this button to bring up your list of messages along with the details of the call.  From this window, 
you may Play, Delete, or Manage the message. 

 

 

 

You will also notice a Deleted tab at the top of the window.  Deleted messages are held in the system for 
7 days allowing you to Restore them or permanently delete them. 

 

 

 

 

Delete Message 
Play Message 

Additional 
Manage Options 
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Other Voicemail Settings 
You may also make other changes to your voicemail services by going into Tools > View Account.  A new 
window will open and there you will find a tab along the top for Message Settings. 

 

 

Voicemail-to-email 
You have the option to send any voicemail messages you receive to your email account.  Messages will 
be sent with the details of the call along with a wav file attachment of the message.  To enable this 
feature, check the Forward messages as emails box.  Then, click the Add and email address link to add 
your email address (you may add up to 5 emails).  Finish by clicking the BLUE                   button to 
commit your changes. 
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Voicemail Greeting 
Expand the Voicemail Greeting section to find options for the greeting callers hear when they reach your 
voicemail.   

Choose from the list of available greetings.  This is handy for enabling and disabling your Extended 
Absence Greeting. 

 

 

If a Greeting has not been recorded, a Record link will be shown to the right of the pull-down. 

 

Clicking this link will open a dialog box where you can record your greeting using the microphone on 
your computer or upload a file if you already have it recorded. 

 

Note – If you are uploading a previously recorded file, make sure that the file is in the correct format.  
Hover over the ? next to the Browse button for file format information.  MP3 files are not supported. 
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